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1 Contact NECS

· Please visit our website at necs.com to learn about our other add-on modules, products and
services. 

· If you would like more information about entrée.PEN, the Anoto Digital Pen interface, please
contact NECS Sales by emailing Anoto@necs.com.

· Contact our NECS Sales Department at sales@necs.com for more information. 

· Contact the Tech Support Department at tech@necs.com for assistance.

· For information about current NECS software training classes use this link: necs.com/
training.php

NECS, Inc. 

322 East Main Street, Third Floor 

Branford, CT 06405

Office Hours: Monday - Friday from 8:30AM EST - 5:30PM EST

Toll Free: 800.766.6327 (NECS)   Phone: 475.221.8200   Fax: 203.208.0889

http://necs.com/index.php
http://necs.com/anoto/
mailto:Anoto@necs.com
mailto:sales@necs.com
mailto:tech@necs.com
http://necs.com/training.php
http://necs.com/training.php
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2 New Features in entrée V4 SQL
The new entrée version 4 SQL software takes the most popular software for food distributors, entrée version
3, and sky rockets it to the next level of power, speed and ease of use. 

The new dashboards, enhanced search screens, ribbon menus, Update Utility and more help you do your job
faster while providing new visual insights of your complex data. This chapter will provide an overview of these
new features to bring you up to speed.

We now use the “Task Execution Application” (TEA) application see the Client Monitor & Task Execution
Services section of this chapter for more information.

· Update Utility

· Schedule Regular Backups

· Using the Task Scheduler

· Client Monitor & TEA

· Using Ribbon Menus

· Using the Auto-Complete Feature

· Using Dashboards

· V4 SQL Search Screens
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3 Using the Update Utility
You will first encounter with the Update Utility during the V4 SQL update process which will transition your
software from entrée version 3 to entrée V4 SQL. During the V4 SQL update process you will setup the
required folders, database accounts and connections to the shared folder and the new entrée version 4
databases. After the update process has been completed you will run both versions of entrée parallel for a
period until your business is ready to only use version 4.

Once your business is fully running only on version 4 you will be using the Update Utility to perform common
file and database maintenance functions. The features of the Update Utility will be discussed in this chapter. 

Update Utility Main Features
· Updates SQL databases & files to the latest entrée version: Allows you to see which of your users are

still logged in before you proceed with the utility. 

· Update Advantage Database Server (ADS) License: Use this process to update your server without
needing to reinstall it. Use the option to change the number of ADS licenses your business has and more.

· Backs up SQL files: Copies your SQL files from their protected directory, into another location where your
backup software can access. Create an editable "Windows Task Scheduler" event to automate the
copying of the files to local or Internet based off site storage. 

· Checks Backup Space: Use this option in the Utilities menu to check potential locations for your backup
to be sure there is enough space before you proceed.

· Restores SQL files: Can take a file or your entire file set to restore and replace entrée SQL file(s). 

· Re-indexes SQL files: For those rare occasions when you need to Re-index a specific file or group of
files, you will only be able to perform that function here. The old "Re-index Files" feature is no longer
available or needed from within the main entrée software.
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· Edit NECS Shared Data Folder: Edit the location of the shared data folder in the event that it must be
moved to a new network location.

· Repair Data:

 Purge Duplicates: Removes duplicate records from SQL databases.

 Validate Character Dates: Reviews and Validates “Character”- style date values.

 Fix Zero Dates

 Fix Contact Manager Sequence values

 Re-link DOC image data

· Check Databases: Checks your SQL databases to see if an update or re-index is required.

· Review Database Constraints: This process will review both the constraints as well as the data in
entrée to be sure all existing data complies with the defined constraints. If not entrée errors could occur.

Rules for Using the Update Utility
1. Only System Administrator level users should ever have access to the Update Utility. 

2. You MUST run the Update Utility on your server which is required when using Sybase Advantage
SQL software. 

3. Running the Update Utility requires that ALL users exit entrée. Use the Show Connected Users button

 in the update utility screen to see who is in entrée.

4.  The V4 SQL databases must be "locked" before an update. Once all users are
out of the system click the Database Lock / Unlock button in the update utility screen to lock the
databases before you perform an update. 

5.  Then click the Database Lock / Unlock button again to unlock the entrée
databases after the update utility work is done.  

 If the Update Utility detects connections from the Task Scheduler the “Click Me!” icon will now
post a message to indicate that one or more Task Scheduler applications are running and will remind you that
you need to lock the databases to shut down those connections. 

· When you issue the “lock” command there will also be a flashing message in red while the Task Scheduler
system processes the shutdown notification. 

· When the shutdown process is complete then the message will no longer be displayed and you should be
able to launch the version update.

Import Authorization File Button
Used to import or update the authorization file from NECS. This file will tell the system what add-on modules
and custom modifications you have purchased. The Import Authorization File dialog box will open. Browse
to find and select the NECS.DAT file on your server and click Open. The NECS.DAT file will be processed by
the Update Utility. The Install Part 2 chapter of the system guide covers the use of this feature when you first
install V4 SQL.
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Informational Tools
In the Update Utility there are a few informational tools to help you understand features in the screen and what
is required for input during the update process. You can easily find software version information menu.

· Help Menu   
Click Help in the menu bar provides
you with version information for entrée,
Windows, and Sybase Advantage
software.  

In the Help About example
shown here the entrée version 
is 4.0.6

 Click Me! Button
Provides information about what other
fields are required before the utility can
be run the first time you update. 

The Information message opens to list
the tasks that must be complete before
proceeding.

    Important / Information Buttons
·  These buttons will provide you with

information about the specific field it is
near on the screen. 

· The Database Administration Account,
Database Access Account, NECS
Shared data folder and the Database
Lock / Unlock button for the SQL
databases all have an Information
button. 

On the right is the Information displayed
for the Database Administration Account
section.
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Database Account Updates
When you first ran the Update Utility you created the required Database Administration Account and
optionally created a Database Access Account. To maintain these accounts and their passwords you will use
the Update Utility.

 Update Account Information Only Button - When you change either the User Name or
Password information for either of the Database Accounts in the update utility you must click the Update
Account Information Only button to update the accounts in the entrée system.
 

 Database Account Security Tips 
· Please be sure to save this login information in a secure place. 

· Only share this information with a limited number of people who require System Administrator access to
your databases. 

· Users with this login information have update access and can modify your entrée databases which can
potentially cause a loss of critical data for your business.

· Use the Update Utility to change the password on this account if you think it has been compromised.

 Multi-Company Note: For businesses with the multi-company add-on module you can check
the Use one account for all companies option to use the accounts set up here for all the companies in
entrée.

Update Brand Information
If you check the "Update brand information from NECS reference database" option box the utility will
update your entrée system brand information from the NECS brand database. 

Keeping this option checked will ensure that you always have the latest brand information for new items you
need to add to entrée. When you include a new brand in entrée, the system will automatically have the brand
logo and website address/URL ready to load if it finds a match. If an existing brand has information missing,
and there is a match in our 600+ brand database, the system will automatically insert the logo and website
address/URL. 

Purge Temporary Files
If you check the "Purge Temporary Files" option box then during the database updating performed by the utility
any leftover temporary files will be purged from the system. This will help to control space usage and system
resources because temporary files can become quite large.

File Menu Options
· Edit Shared Folder - There may come a time when due

to space limitations or some other reason you need to
designate a different location for your NECS Shared data
folder. This is when you would use the Edit Shared Folder
option in the File menu.
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When the Edit Shared Data Folder dialog opens click in the folder name text box and enter the new
location or use the Browse button to find and select the new folder you have setup. You must get the
Location verified message displayed in the image below to proceed. 

If your location can not be verified here your location may not be shared with Read/Write permissions on
your network. Click Cancel and check the folder settings on your network.

 Information message
displayed for Shared Folder
in the Update Utility will
provide useful details.

About the NECS Shared Data Folder
For version 4 you will need to have a location set up for the required NECS Shared data folder on
your network. You need to specify this location in UNC format. 

 For example: \\MyServer\NECSShared, where “MyServer” is the name of your
local server. 

 All entrée users must have Read / Write permission for this folder. 
 The NECS Shared data folder stores the entrée Help files, imported and exported files and output files.

· Exit - Use this option to exit the entrée SQL Database Update Utility. 

View Menu Options
· Show Connected Users - Use this option to see what

users are logged in the entrée system in the Active Database
Connections screen. 

· Before you perform an update with the entrée SQL Database
Update Utility ALL users must be out of the system and the
databases must be locked.
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Application ID Values in Show Connected Users
· Application ID beginning with “ECM” are part of the entrée Client Monitor system and do not affect the

operation of the Update Utility.

· Application ID value of “ENTREE_V4” are connections opened by a regular copy of entrée. These IDs are
actual users in the entrée system. We recommended that you have those users exit entrée before you
issue the “lock” command. This will prevent the loss of documents or data that the user was working on.

· Application ID value of “NECS.exe” will normally be secondary connections to the database which were
opened by one of the other applications in the list.

1. A list of users in the system is displayed. You can contact them to log out. 

2. Once all users are out of the system, click the Database is Unlocked button. The databases will now
lock and the button text will change to the Database is LOCKED.

3. When your update is complete click the Database is LOCKED button to unlock the entrée databases
again. Now your users can login to work.

4. Send out a message system-wide to notify users.

· Show Connected Users - Refresh Automatically Option - When this option is checked the list of

user in the entrée system will update automatically when users login or exit the system.

· Show Connected Users - Detailed View Option - When this option is checked more detailed

information about the users and their  computer  logged into the entrée system is displayed. 

Active Database Connections screen columns:

 Machine Name: The name assigned to the user’s computer.

 User Name: The user’s name in entrée.

 Application ID: The application in entrée that the user is currently working in.

When the Detailed View option is enabled these additional columns are displayed: 

 Comp #: The number of the Company in entrée where the user is working.
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 Database User: The Advantage user account that is being used to access the database for
the connected users information. It can be one of the accounts you created in the Update
Utility or the “AdsSys” master account as seen in the image above.

 Network Address: IPC connection number of the Terminal Services host machine.  

 Term Client Address: The client address of a user connected through Terminal Services,
which for a normal direct client connection is "0.0.0.0".

· Show Database Information - Allows you to view and print detailed information about the various data

tables which comprise an entrée database. The main use for such information would be if you were using an
external program like Crystal Reports to access your entrée data since you need to know the internal
structure of a table in order to correctly access the information it contains. 

1. To find a database enter the table name if know in the Table selection list text box or use the scroll bar on
the right to scroll through the database list and make your selection. 

2. Once you select the database the Field and Index information for the table will be displayed in the
sections below. Here we have the Vendor Item Information database.

3. Printing Database Information - Click the Print Table Data button when you have the desired table
displayed. 

· You can currently only print table data one file at a time. 

· The print process is not “dot-matrix friendly” so if you choose to print data you must use an ink jet or
laser printer.

4. Click Close when done.
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 Here is the printed Table Description for ARVEND.
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Utilities Menu Options 

A. Check Databases

B. Review Database Constraints

C. Update Advantage Database Server
Licenses

D. Reindex 

E. Recopy Workstation support files

F. Repair Data

1. Purge Duplicates

2. Validate Character Dates

3. Fix Zero Dates

4. Fix Contact Manager
Sequence Values

5. Re-link DOC image data

G. Schedule Regular Backups

H. Backup Data Now

I. Restore Data Now

J. Check Backup Space

K. Disable entrée Client Monitor system

A.   Check Databases - When you click the Check databases option in the utilities menu the Database

Review screen below will open. It will immediately begin running a check of all the entrée databases. 

This check is similar to the one that you ran for entrée version 3 that was part of the “FPUdate Utility”.
The dials will show the progress as the File Count below increments until the process has completed.  
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· File Status Report - Once the Check Databases process has completed the File Status screen will
display and report on all the databases.

  If an update is needed a red bar
with “Update required” will be
displayed at the top of the screen.

 The File Name column lists each
database. 

 The File Status column tells you
the current status of the database,
either OK or Index.

· Show only tables which require
updating option - Check this option
to display only the list of databases
that require updating

 

B.   Review Database Constraints
- This process will review both the

constraints as well as the data in 
entrée to be sure all existing data
complies with the defined
constraints. If not entrée errors
could occur.

 It may take hours to
run this process depending on
database size.

· When you click the Review Database Constraints option in the utilities menu the first screen that is
displayed is the Confirm dialog.

· If you would like to proceed click Yes. 

What are database constraints?
Constraints are rules applied to certain fields in a database. These rules help to keep the data compatible with
applications that use the data.  The dials will show the progress as the File Count and Company Processing
readings increment until the process has completed. For our small testing database it took around 30 minutes
to run. An Information box will display the message Database review process is complete when the

processing is done. For "Numeric" fields the "not NULL" constraint and the "Default" constraint that sets

uninitialized fields to zero has been applied. 
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C.  Update Advantage Database Server Licenses - Update your Advantage Database Server license

so you can add more users.  

1. Select Update Advantage
Database Server
Licenses from the Utilities
menu.

2. Click the License button. 

3. Your current license Serial
Number will  be displayed
(we blurred our info). 

Enter the Validation Code
provided. 

Entering a new Validation Code with the existing serial number allows for expansion of the Advantage
Database Server to a higher number of users, such as from a 10-user version of the Advantage Database
Server to a 25-user version. 

The registered owner information and startup type (if on Windows) can be updated from this dialog as well.
That ANSI Character Set and OEM/Localized Character Set dialogs may follow. Different character sets may
be selected from these dialogs.
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4. Click Next.

5. Verify the Registered
Owner information. 

6. Keep Automatic Startup
checked and click Next.

You are back at the ADS
Stamp Utility main dialog
screen.

D. Reindex Databases - Select the Company Name and the list of databases will be populated in the

Available for Reindexing list.

For Table Selection choose from: 
 Reindex all tables:  When this option is checked all tables are automatically selected. 
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 Reindex selected tables: Once you check this option, drag and drop the desired tables from the
Available for Reindexing list to the Selected for Reindexing list.

 Direct Entry: In this text box you can enter the comma separated names of databases you would
like to run reindex.

 

 Before you run a Reindex you should go to the View menu and use the Show
Connected Users  feature to see what users are in the system. 

Running a Reindex 
1. Send a message to request users log out of the system prior to the Reindex.

2. Now use the Database Lock button and lock the databases before you run the Reindex utility.

3. Once you have made your Table Selection and made sure all your users are logged out of the
system click the Start  button to begin the reindex process.

4. When the reindex process has completed a Reindexing completed Information message box will
display.

5. Send a second message to notify users it is done. 

E.  Recopy Workstation support files -  When a new version of the Update Utility is installed on your

server matching installers for the workstations are also provided. These workstation installers are placed in
a "WS" folder underneath the Update Utility's folder which is not accessible to you. This utility copies the
workstation update files from the private "WS" folder into the shared "WSUpdate" folder so you can access
the files update your workstations. The folder is created by the installation process and should always be
present. If the folder is missing then you have no way of publishing your workstation updates. Contact
NECS Tech Support for assistance with creating the missing folder.
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F.  Repair Data menu options: Purge Duplicates, Validate Character Dates, Fix Contact Manager

Sequence Values and Re-link DOC image data.

1. Purge Duplicates - The Purge Duplicates feature will remove duplicate records in key files like the Inventory
file where you commonly have this situation. Select the correct Company Name and the list of databases
will be populated in the Available for Duplicate Removal list.

Purge Table Selection options: 
 Purge all tables:  When this option is checked all tables are automatically selected. 

 Purge selected tables: Once you check this option, drag and drop the desired tables from the
Available for Duplicate Removal list to the Selected for Duplicate Removal list.

 Direct Entry: In this text box you can enter the comma separated names of databases you would
like to run the duplicate removal process against.
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 Before you run the purge duplicate process you should go to the View menu and use

the Show Connected Users  feature to see what users are in the system. 

Running Purge Duplicates 
1. Send a message to request users log out of the system prior to the purge.

2. Now use the Database Lock button and lock the databases before you run the purge duplicates.

3. Once you have made your Table Selection and made sure all your users are logged out of the
system click the Start  button to begin the purge duplicates process.

4. Once the purge has completed a Duplicate removal completed Information message box will
display. 

5. Send a message to notify users the purge is done.

2.  Validate Character Dates - The utility will review the “Character”- style date values and assure that they

are all valid. It will also removes any date values that do not represent valid dates in Advantage so they
will not produce errors and end the database operation that was in progress. 

a. When you click the 
Validate Character Dates
option in the menu the
validation will automatically
run and a progress dialog
will display.

b. Once the validation is done
for your 01 Company in 
entrée and Information
dialog box will display 
"Scan Complete... All 
Dates verified". Click OK.

c. The Validation Complete
message will display with
the company name and
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number whose dates were
validated. Click OK.

3. Fix Zero Dates - In the system “unknown” dates were being recorded in the database as

“12/31/1899” but not being converted properly when added to some databases. When entrée sees
one of these 1899 dates being written to the database it is supposed to save it as a “null” value.
We found in a few places this was not being properly enforced and there are now entries in the
database which have the 1899 date. Areas of the system causing the date problem have been
updated so this date problems will no longer occur.

The Fix Zero Dates utility automatically runs as a part of the 14.0.18 release update. This run will
find and fix all those 1899 dates and produces the Scan Results dialog (below) which you can 
Save or Print using the buttons. Click OK to close.

· When click Fix Zero Dates it
will immediately begin to run
and a progress dialog will
display.

· After the run in the 4.0.18
update the Validation
Complete message box will
display at the end.  Click OK
to close.
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4. Fix Contact Manager Sequence Values -  This resolves data issues created by the

resetting counters stored in the “CMSeq” table in the “4.0.2” release. The utility will run
automatically when it detects that it is updating a database from the “4.0.2” release or older.

a. In the Repair Data drop
down menu click the Fix
Contact Manager
Sequence Values 
option.

b. Click the unlock/lock
button to lock the
databases.

c. Click the Go button.

5. Re-link DOC image data - This repair utility will scan the entrée.DOC image database and

correct data errors produced by earlier versions of the .DOC image import process which could
prevent you from retrieving your document images. There is nothing wrong with the image data
itself, there is just a problem in the extra data which is used to connect the entrée document with
its scanned image. 

· Click the option and
the scan will begin
automatically and
display the results.

· Click OK and the
Validation Complete
message will display
and you are done.
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G.  Schedule Regular Backups - You have already run the Check Backup Space utility and analyzed

various storage devices on your network so you will know if your selected device will be able to store your
SQL databases. 

Once you find the best place for your database backups, taking into consideration that they will grow larger
over time, you can proceed to the Schedule Regular Backups utility.

 You must be sure there is enough space on the selected device to store
your database backups. Be sure to run the Check Databases utility before you make a new
folder on a storage device to be sure that you have enough space.

 When you click the Important button the informational note here is displayed. 

 Add Task: To schedule regular backups use the Add task button to create your schedule. 

· You will need to decide how often you need to backup your system based  on the volume of your
business. 

· It is strongly suggested that backup jobs be run after business hours when there is no activity in entrée.

· Then you can proceed to build your schedule of backup jobs using the Add Task button. 
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How to Add a Backup Task to the Scheduler
1. Once you click the Add Task button the Edit Backup Task screen will open. Here you will build the

backup jobs that will be run by the Scheduler. 

2. The Important button message previously shown can be used here for more information. 

3. Set your Edit Backup Task screen options which are discussed next. 

4. Make selections for the Edit Backup Task screen fields:

Back up data for: 
 Back up ALL databases: Select this to back up all your databases.
 For customers with multiple companies your 01, 02… companies will be listed here. Use this drop

down menu to select the desired Company Name from the list. 

Back up to: 
 Use the Browse button to locate the device and select a folder to store your database backups. 
 Or use the Make New Folder button in the Browse dialog to create a folder for your backups. 
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Settings Section:  
a.  First select the frequency of your scheduled database backups:

 Daily
 Weekly
 Monthly

                                                                             
b.  Enter the desired date and time in
the Start section.   

Date settings:
 Click the arrow to reveal

the calendar and select
a start date for your
task. 

 Or use your keyboard
to enter the desired
date.

Date Information: The Information
box here is part of the explanation for
setting dates and how they work in
the system.

Time settings: 
 Click the Hour area and use the arrows to set the desired hour for the backup run.
 Click the Minutes area and use the arrows to set the desired minutes value.
 Click the AM / PM area to make a selection for the backup task.

Options:
 The options information in the area below the Date and Time settings will change with

your choice of backup frequency, Daily, Weekly or Monthly. 
 In the screen above you see the “Recur every” option for daily backup tasks. Click the

number to change the daily recurrence frequency.

Task Description:
 Enter a simple description for the backup task you are creating. As an example your

can write "Daily backup of company 01 databases."

5.  After you save your new database backup task it will be added to the list in the Schedule Backup Jobs
screen.
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H.  Backup Data Now
· Output folder: Similar to the previously mentioned database utility screens the Browse button is used to 

locate the storage device and select or make a folder to store your database backups.

· Company Name: Select the company and the list of databases will display in the Available for Backup
list. 

· Either Backup all tables or Backup selected tables and use drag and drop to the Selected for Backup
list.

In the example above we have selected Backup all tables. If you would like to backup specific tables use
the Backup selected tables or Direct Entry options.

· The Direct Entry option is available with Backup selected tables so you can enter comma separated
database names for backup.

 If the network can see a device you can select it and backup your databases there. 

I.  Restore Data Now
· Source folder: The opposite of the Backup Data Now utility, the Restore Data Now uses a similar screen

to Browse and locate the device and folder where your backup of the SQL databases are stored. 
 
· Select the Company Name and the list of databases will display in the Available for Restore list. 

· Either Backup all tables or Backup selected tables and use drag and drop to move databases to the
Selected for Restore list.
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 In the example above we have selected the Restore selected tables option because only
one database needs to be restored. The database was dragged from the Available for Restore column to the
Select for Restore column.

· Direct Entry: In this text box you can enter the comma separated names of the specific databases you
would like to restore.

 Before you restore databases you should go to the View menu and use the Show
Connected Users feature to see what users are in the system. Then ask the users to sign out before
you begin.

Running a Restore 
1. Send a message to request users log out of the system. 

2. You must click the Database is Unlocked button to lock your databases before the restore job can run. 

3. When your restore is complete click the Database is LOCKED button to unlock the entrée databases
again. 

4. Send a message to notify users when the restore is done.
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 Edit with Task Scheduler

On the Schedule Backup Jobs screen you will see the Edit with Task Scheduler button. Use this button to
access the more advanced features of the Windows Task Scheduler. The next topic covered will be Using the
Task Scheduler.

J. Check Backup Space - Before you designate a device and folder to store your company database

backups you should use the Check Backup Space feature to analyze the space available in potential
locations.

· Browse to select a folder for your backups. Then click GO to run the backup space check. This process
should run very quickly since it is just analyzing space availability.

Back up data for: 
 Back up ALL databases: Select this to back up all your databases.

For customers with multiple companies your 01, 02… companies will be listed here.

 Use the drop down menu to select the desired Company Name from the list. 

Browse: Use the Browse button
to locate the device. 
 Select an existing folder. 

 Or use the Make New
Folder button to create a
folder for your backups. 

· Here we created a folder with
using NECS, the company
number and letters
representing the back up
function called "NECS01-
BkUp".
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· When the space on the device
has been analyzed an
Information message box will
display with the statistics and
tell you whether you databases
will fit in the location. 

K.  Disable entrée Client Monitor system

This is a switch to disable the entrée Client Monitor System and bypass it to let entrée run. Once the
option is checked any running copies of entrée will disconnect from the monitor. Instances of entrée linked to
the Task Execution Service (TES) will finish the currently started job if applicable then disconnect and
terminate. 

Once the monitor feature is unchecked, any running copies of entrée will plug back in without any notification
to the user. The Task Execution Service will also restart its copy of entrée when it sees the client monitor is
running again and without any interaction with the users other than turning the monitor back on.

 This option should only be used if NECS Tech Support advices you to disable the
Client Monitor.
 
· With the Client Monitor disabled, the Task Execution Application (TEA) shuts down completely because

without the Client Monitor there is no way to control the execution of tasks on remote machines (Mainly an
issue during updates to the database). 

· With the Client Monitor shut down the Update Utility can no longer remotely notify running instances of 
entrée that they need to shut down for an update, so the distributor is back to running around the building
telling people to close entrée.
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3.1 Schedule Regular Backups
It is easier and quicker to create and delete your backup jobs using the Update Utility > Utilities menu >
Schedule Regular Backups option.

 Use the  Add Task button in the Schedule Backup Jobs screen to create and schedule
regular backups of your version 4 SQL databases.

· Back up data for: If you only have one company select Back up ALL databases from the drop down
menu.  
 If your system is set up with as a multi-company you will select the desired company's database files

from the companies listed in the drop down menu.

· Back up data to: Use the Browse button to locate the destination drive and folder for your backups to be
written to. You can create an empty folder in the selected location prior to performing this step.
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· Settings:

 Daily Settings

 Weekly Settings

 Monthly Settings

· Task Description: Enter a description of the task to be run.
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· The note seen when you click the Important button. 

 Select a task and click the Delete Task button in the Schedule Backup Jobs screen to
delete a backup job.

Resetting Failed Tasks
You have the ability to reset the status of a task that started to execute but for whatever reason failed to
complete either with or without errors. The task failure could be due to a service restart or some other system
failure. If a task is executed and completes with errors it will automatically be placed into a suspended state. 

Go to the Scheduling Utility chapter of this guide to learn about how the Restore Task option is used to
reset the status of a suspended task. The Restore Task option will only be displayed if the selected task is
either running or in a suspended state.

Edit with Task Scheduler
· To maintain scheduled backup jobs access the Task Scheduler via the Update Utility > Schedule

Regular Backups window. 
· In the Schedule Backup Jobs window click and select the job you would like to edit. Then click the

 Edit with Task Scheduler button.

· The next section of this guide will cover the Task Scheduler.
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3.2 Using the Task Scheduler
The Task Scheduler is used to maintain the backup jobs scheduled Using the Update Utility. The Task
Scheduler, which is a more advanced tool in Windows, will schedule and run many jobs including Microsoft
software updates and updates to other software packages installed on your computer. 

You can use the Task Scheduler to create and manage common tasks that your computer will carry out
automatically at the times you specify. 

Tasks are stored in folders in the Task Scheduler Library. To view or perform an operation on an individual task,
select the task in the library and click on a command in the Action menu.

 Be sure to go to the Scheduling Utility chapter of this guide to learn about scheduling tasks
using this option in the entrée System ribbon menu.

1. To access the Task Scheduler run the Update Utility > select  Schedule Regular Backups window.
 
2. In the Schedule Backup Jobs window click and select the job you would like to edit. 

3. Click the  Edit with Task Scheduler button.
 
· Task Scheduler Main Menu

File, Action, View, Help

· Tool Bar (from left to right)  
Back arrow, Forward arrow, Up One Level,
Show/Hide Console Tree, Help, Show/Hide
Actions Pane.

· Task Scheduler Library: Click it to see all scheduled tasks and the menus. The Advantage backup that is
highlighted is the task that will back up your entrée databases. 
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· Scroll to the right to see the rest of the columns for the tasks (below).

· Task Scheduler Action Menu

· Task Scheduler Help Menu:         

For more information about using the
Task Scheduler use the Help menu
> Help Topics option.

· Create a basic task using the
wizard

1. In the Actions pane, click 
Create Basic Task.

2. Follow the instructions in the
Create Basic Task Wizard.

· Actions Pane - When you click on a
task the options in the pane will
expand to include what is seen on the
right.



Using the Update Utility 36

· Create a Task

1. Find and click the task folder in the console tree that you want to create the task in. If you want to create
the task in a new task folder, see Create a New Task Folder to create the folder.

2. In the Actions Pane, click Create Task.

3. On the General tab of the Create Task dialog box, enter a name for the task. Fill in or change any of the
other properties on the General tab. For more information about these properties, see General Task
Properties.

4. On the Triggers tab of the Create Task dialog box, click the New… button to create a trigger for the task,
and supply information about the trigger in the New Trigger dialog box. For more information about
triggers, see Triggers.

5. On the Actions tab of the Create Task dialog box, click the New… button to create an action for the task,
and supply information about the action in the New Action dialog box. For more information about actions,
see Actions.

6. (Optional) On the Conditions tab of the Create Task dialog box, supply conditions for the task. For more
information about the conditions, see Task Conditions.

7. (Optional) On the Settings tab of the Create Task dialog box, change the settings for the task. For more
information about the settings, see Task Settings.

8. Click the OK button on the Create Task dialog box.

· View a Task's Properties    

1. Find and click the task folder in the console tree that contains the task you want to view.

2. In the console window, click the task that you want to view.

3. Click Properties in the Action pane. The Task Properties dialog box will appear.

4. In the Task Properties dialog box, the task's properties are located on the General, Triggers, Actions,
Conditions, and Settings tabs. Click a tab to view the properties. 

5. Click the History tab to view the task's history. 

 Task history can be enabled or disabled. In the Action pane, click Disable All Tasks History or
Enable All Tasks History to change the Task History display.

 Click an event in the list of events on the History tab to view the description of the event.

· Display All Running Tasks 

1. In the Actions pane, click Display All Running Tasks…. The Running Task dialog box will appear.

· Disable a Task from Running

1. Find and click the task folder in the console tree that contains the task you want to disable.

2. In the console window, click the task that you want to disable.

3. In the Actions pane, click Disable. The Disable command will only be available in the Actions pane if the
task is enabled.
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· Enable a Task to Run 

1. Find and click the task folder in the console tree that contains the task you want to enable.

2. In the console window, click the task that you want to enable.

3. In the Actions pane, click Enable. The Enable command will only be available in the Actions pane if the
task is disabled.

· Delete a Task

1. Find and click the task folder in the console tree that contains the task to delete.

2. In the console window, click the task to delete.

3. In the Actions pane, click Delete.

4. In the Confirm delete dialog box, click Yes.

· Delete a Task Folder 

1. Find and click the task folder in the console tree that you want to delete.

2. In the Actions pane, click Delete Folder.

3. In the Confirm delete dialog box, click Yes.



Chapter 4
Client Monitor & Task Execution

Application
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4 Client Monitor & Task Execution Application

Viewing Services Running Using the Windows Task Manager 

1. Hit the CTRL + ALT + Delete keys simultaneously and you will open a Windows menu. 

2. Select Start Task Manager and the Windows Task Manager will open.

3. Click the Services tab.

4. Then click the Services button in the lower right corner to view the Services dialog.

5. Scroll down the list to locate these NECS services:

a. NECS entrée Client Monitor Service 

b. FaxMan Fax Engine 

c. NECS Task Execution Application

6. In the Windows Services dialog window you can Stop, Pause and Restart the NECS entrée Client
Monitor and other services. 

· You can also turn off the NECS entrée Client Monitor
in the Update Utility > Utilities menu.

  This disable option should only be
used if NECS Tech Support advices you to disable
the Client Monitor.

 About the Disable entrée Client Monitor option 

· Once the disable option is checked in the Update Utility any running copies of entrée will disconnect from
the Client Monitor. 

· All instances of entrée linked to the Task Execution Service will finish the currently started job, if any, and
then disconnect and terminate the Task Execution Service. 

· Once the Client Monitor feature is re-enabled by removing the check in the Update Utility Utilities menu,
any running copies of entrée will plug back in without any notification to the user. 

· The Task Execution Service will restart its copy of entrée when it sees that the Client Monitor is running
again without any interaction with users other than turning the monitor back on.

NECS entrée Client Monitor (ECM) 
· The entrée Client Monitor service manages and tracks all the entrée client connections (workstation

computer connections) for the network.
· The entrée Client Monitor will create a new log file when the system date changes for each day.
· Client Monitor works with the Update Utility to remotely notify running instances of entrée when they need

to shut down for an update.
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NECS Task Execution Application (TEA) 
· The Task Execution Application works through the entrée Client Monitor (ECM) to control the execution of

scheduled tasks on remote computers, like running reports. 

· See the Using the Task Scheduler topic in the Using the Update Utility section for more information
about the Scheduler. 

Welcome toTEA
We have replaced the “Task Execution Service” (TES)
application with the Task Execution Application, or
“TEA” (pronounced “tee”) for short. 

TEA is designed to run in the system tray as shown on
the right.

We have transitioned to TEA to assist with diagnosing any intermittent problems with scheduled tasks. TEA
will also show any prompts or messages from scheduled tasks that require you to respond to them so they
can continue running. 

TEA interacts with the main entrée application to perform tasks for some scheduled processes like the
display of prompts, warning messages and dialog boxes requiring user responses for tasks. During the work
day when entrée is running these messages pop up, you respond to them and the tasks continue to run and
complete. 

Running TEA
1. Go to the server where your entrée system software is installed.

2. Open your designated Program Files folder.

3. Find the NECS folder then  > open the entree folder. 

4. Double-click the NECS_TEA.exe executable module and it will run, but you will not see it.

5. To see if TEA is running you have two options; the Windows Task Manager or the Update Utility.
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5a. Open the Windows Task Manager by hitting the Ctrl + Alt + Delete buttons at the same time. 
Select the Task Manager option. When the Windows Task Manager opens and you will see
NECS_TEA.exe along with NECS_ECM.exe and if the entrée system is running you will see NECS.exe
(image below).

5b. Or in the Update Utility click the Show Connected Users button. Here you will see all the users and
services running on the database server including NECS_TEA.

6. This step is only for customers who have the entrée.NET add-on module. 

You will need to add your entrée.NET import and export tasks back into the scheduler so they will run.

a. Go to the System ribbon menu System Utilities section and run theScheduling Utility.

b. Select a Task Type of Process and select a Category of Import / Export.
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c. In the Option drop down menu select from the entrée.NET Export and entrée.NET Import to schedule
these processes.

d. Click the Configure button (we have selected the
entrée.NET Export option) and the Scheduled
Export Configuration dialog opens.

e. Select the desired Export Mode from the drop
down menu and click OK.

f. Continue with setting up the rest of the process
schedule as you would for any other task. For more
information you can consult the Scheduling Utility
chapter in this guide.



Chapter 5
Using the Ribbon Menus
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5 Using the Ribbon Menus
The purpose of this chapter is to provide you with a detailed overview of the features of the version 4 Ribbon
Menu feature, the new method of navigating within your entrée application. This new feature will provide you
with faster more intuitive menus. All the menu options have a graphical icon which visually represents what that
menu choice accomplishes. Once the user is used to the visual icon, they can identify the menu option much
faster than reading a menu title.

Menu options related to each ribbon category are grouped together. This makes it easier for the user to find
what they is looking for. As an example, on the "Inventory" ribbon, all options related to inventory, including file
maintenance, transactions, reports and utilities are grouped together. The same is true for the other ribbon
elements of "Customer", "Vendor", "Salesperson", etc.

Frequently used menu options can be set by the user and added to the "Quick Access Toolbar", which can
appear directly above the ribbon menus or below them. Previous versions of entrée had a similar concept
called "My Menu".

Clicking on the "V4 SQL" in the circle at the top left of the ribbon menu, as well as the small down arrow
button to the right of it, will bring up additional options, such as "Show Login Screen" and other commands.

As option for a new V4 SQL installations, below the ribbon menu will appear the older "Legacy" menu
structure. This was included so that users familiar with the old style menu of entrée could feel comfortable
while they adapted to the newer ribbon style. The Legacy menu format can be turned off in the System ribbon
menu System Preferences area in the System Options section. Previous hot keys used by entrée for menu
selections are fully supported.

Previous hot keys used by entrée for menu selections will continue to be fully supported in
the entrée V4 SQL version. 

Ribbon Menu Overview
The V4 SQL release of entrée includes a new Ribbon menu that organizes menu options into a tabbed
interface. This new menu uses distinctive visual icons for each menu option providing you with a quick and
intuitive way to interface with entrée. 

· V4 SQL Menu
The "V4 SQL" icon in the top left of the ribbon menu or the drop down arrow, will reveal general options like
"Show Login Screen" and the Exit command to close entrée. The menu is accessed by clicking on the V4
SQL circle icon (outlined in red in the image) in the upper left corner.
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Options are:
 Recent Tasks
 Window
 Show Login Screen
 Change Working Date - Use this

tool to enter invoices using a
different default date for the invoice
and order dates. 

Changing the default date works for
all parts of the system that use the
current date, such as cash receipts
and receiving inventory.

 Exit View your Recent Tasks in the list on the far right.

The Ribbon Menu allows you to access the entrée application main data files; Inventory, Customer, Vendor,
Salesperson, Dashboards, System and Add-Ons. Menu options related to each ribbon category are grouped
together. This coupled with the icon images make it easier for entrée users to find what they are looking for. 

· Inventory Menu
On the "Inventory" ribbon menu above, all options related to inventory, including file maintenance, transactions,
reports and utilities are grouped together with the group caption below it like “Inventory File”. Menu options with
a down arrow to the right have a drop down menu of options.

In the Inventory ribbon menu you will find these sub-menus: Brand, Class, Manufacturer, and sections for
Inventory Transactions, Reports and Utilities. 

· Customer Menu

· Vendor Menu



Using the Ribbon Menus 46

· Salesperson Menu

· Dashboards Menu

· System Menu

· Add-Ons Menu
The Add-Ons ribbon will provide access to the options related to any of our add-on products you may have
purchased to enhance and expand the performance of the entrée system. In the ribbon menu below
entrée.DOC, used for document scanning and entrée.DOT, the DOT Foods interface, entrée.NET for Internet
based e-commerce are some of the add-on modules a customer can purchase to enhance entrée. Please visit
our website at necs.com to learn about our other add-on modules, products and services.

http://necs.com/index.php
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· Minimizing the Ribbon Menu 
You have the option to minimize and restore the Ribbon menu whenever you like. Click the down arrow in the
upper left corner of the screen near the V4 SQL icon and Quick Access Toolbar area to reveal the Ribbon
menu options. 

Or you can right-click any ribbon command and check the Minimize the Ribbon option. This is an example of
the minimized menu.

To restore the Ribbon menu, right-click any command or page and uncheck the Minimize the Ribbon option. 

You can also minimize or restore the Ribbon menu by double-clicking any tab page header. 
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5.1 Quick Access Toolbars
The Quick Access Toolbar can easily be customized to store your most frequently used entrée commands.
The Quick Access Toolbar has replaced the “My Menu” feature you have seen in previous versions of entrée. 

At the top of the ribbon near the V4SQL is a square icon you right-click to view the saved commands in the
Quick Access Toolbar. These commands are also listed in the menu drop down list. One way to remove a
command from the Quick Access Toolbar is to uncheck it here.

Click the down arrow in the upper left corner to reveal the saved commands. 

From this drop down menu you can control your saved commands and the position of the Quick Access
Toolbar in the Ribbon menu. 

· Customize the Quick Access Toolbar
To add a group of commands to the Quick Access Toolbar, right-click the group's caption and select Add to

Quick Access Toolbar.

To add any command to the Quick Access Toolbar, right-click the icon in the ribbon menu and click Add to
Quick Access Toolbar. Notice that in this image no command icons have been added to the Quick Access
Toolbar. 
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To remove any command from the Quick
Access Toolbar, right-click the icon image
and click Remove from Quick Access
Toolbar. 

To position the Quick Access Toolbar and select either Show Quick Access Toolbar Above the Ribbon or
Show Quick Access Toolbar Below the Ribbon. In the image below it is positioned below the ribbon menu.

· Customize Toolbar Options
1. Right-click on the main ribbon menu

toolbar and select More
Commands.... 

2. Click the Options Tab.

3. Select from options and click Close. 

Personalized Menus and
Toolbars 

 Menus show recently used
commands first.

 Show full menus after short delay.

Reset my usage data - Click to clear
out the recently used commands that
were saved when the Menus show
recently used commands first option is
enabled
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Other
 Large Icons
 Show ToolTips on toolbars.
 Show shortcut keys in ToolTips.
 Menu Animation options 

The animation you select will be applied
to menus that use a drop down arrow to
access the menu options.

5.2 Creating Custom Toolbars
Adding a custom toolbar will allow your tasks to move more quickly by eliminating the need to find the menu
for your task. Follow this simple process and save time every day.

· Add a Custom Toolbar
1. To create a custom toolbar tailored to

your work click the Quick Access bar
menu down arrow and select the More
Commands.... option. 

2. In the Toolbars tab click the New
button to create a new customizable
toolbar. 

3. The Add Toolbar dialog will open.
Enter a name for the new toolbar.

4. Click OK. 
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In our example we created the Office
Clerk toolbar which can now be found
in the list on the Toolbars Tab.
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Your New Custom Toolbar
When the Office Clerk toolbar is first created it is
empty and will look like a little box with dots and
an arrow (image below). 

The vertical row of dots on the left are the handle
for positioning it. The custom toolbar will stay
where it is docked unless you move it.

Click the handle and drag the toolbar to any
location you like on the screen or even on your
computer desktop. 

You can also dock it on the right or left
side as a vertical toolbar.

· Now you get to make your command selections for the new custom toolbar.

5. Click the Commands tab to add commands,
menus and reports to this new custom
toolbar.  

The Legacy menu groups have an * asterisk
preceding their names.

The V4 ribbon menu groups have the > right
arrow preceding their names.

6. Scroll through the Categories list to find  the
desired commands, listed on the right, to
add to your toolbar. 

Here the Customer Groups category was
selected. 

Groups are a collection of menu options from
an option in the ribbon menu in entrée.

In Commands the Customer Groups menu options are listed. Scroll through the list and drag your selections
to the Office Clerk toolbar on the screen. 
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Once the first command is added it will expand the toolbar area.

In our Office Clerk customized toolbar we dragged in the Invoice,
Statements, Print and Cash Receipts from the Customer category
commands.

When you click on the down arrow of Invoice in the Office Clerk
custom toolbar you have access to the entire Invoice menu.

When you drag reports from the Commands list into
your toolbar the report name will be listed and easy
to find.

7. Click Close when you are done creating your
customized toolbar.

· Editing a Custom Toolbar
1. In the Office Clerk toolbar click the drop

down menu arrow and select Add or
Remove Buttons.

2. Remove the check from the button in the list and
it no longer displays in the toolbar.
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· Delete a Custom Toolbar
You have two options for the removal of custom toolbars.

1. To keep the custom toolbar but no longer display it go to the Toolbars tab and remove the check from the
box.

OR

2. To delete the custom toolbar from the system select it then click the Delete button. Then click OK on the
delete confirmation dialog message



Chapter 6
Using the Auto-Complete Feature
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6 Using the Auto-Complete Feature
Auto-Complete, the latest feature to be integrated into entrée V4 SQL, was first showcased in the Vendor File
Maintenance redesign. Now the Auto-Complete feature has been integrated into many other areas of the
system such as the “Customer Number” field in Create Invoice, the “Invoice Number” field in Change Invoice
and the “Item Number” field when adding items to an invoice just to name a few. 

The Auto-Complete feature will provide a speedier search and selection method for all users. This new feature
will increase productivity in order entry, sales, purchasing and in every department that uses entrée V4 SQL. 

Satisfaction with your customer service will increase as your order takers easily find and change orders on the
fly for customers while they are on the phone.

Based upon our customer feedback for this feature, we will begin to add this feature throughout the entrée V4
software.

The Auto-Complete feature can easily be turned off by removing the check from option #112, Use Auto-
Complete feature in Create/Change Invoice, for each entrée user through the Security Management
Miscellaneous system options. If you have a large number of user and would like a SQL command to perform
the update please contact your NECS Tech Support team member.

How Auto-Complete Works
You can use as many as three words with a maximum of 20 characters to search within an auto-complete
field. As you enter each character or word into the field the Auto-Complete feature will try to figure out what you
are entering as you type. It updates the drop down list of auto-fill values with values that are already used for
the field in the database. 

Auto-Complete performs the look-up by searching multiple fields (such as Item Number, Brand Name and
Description when looking up an item) and returns the first 500 matching results found. This means that even in
the “Item Number” field you can start typing in the item's description and locate the desired item that way. 

You have the ability to easily add new entries on the fly while using the auto-complete feature. Type the new

identifier for a new Item or Customer in the field and click the "Create New"  button. entrée will open the
proper dialog to initiate the creation of the new entry in the database. 

When you type a new identifier and a list of matches are found in the database. If you hit the <Enter> key the
first match will be loaded. If the look-up process matches an existing item it will load that item instead of
starting a new entry. Or just click and make a selection from the look-up match results. 

If no values have been saved for the field in the database a blank value and <No data to display> will be seen
in the auto-complete look-up match results. 

Of course the regular entrée search system is still available by clicking the magnifying glass  or by
hitting <F5> on your keyboard.

Configuring Auto-Complete Lookup Settings 

Here you see the auto-complete feature in the Customer File for the customer number. Each entrée user can
now configure they own settings for each field using the auto-complete feature. We will use the Cust. Number
in the Customer File for our configuration example. 
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1. In the Auto-Complete window click the Configure icon in the bottom left corner of any auto-complete
window to open the Lookup Configuration… dialog.

2. For the Input text with more than one word should display option select how you want to handle the
search terms containing two or more words. The available options are: “Any word”, “All words” and “Exact
phrase”. The default is “Any word”.

3. Check the Display option for the fields you want to see in the auto-complete window.

4. Check the Search option for columns you want the auto-complete to use in the search.

5. Double-click in the Match Type option to access the menu to make a selection for each search field that
you checked.

6. Double-click in the Sort option to access the menu to make a selection for each search field that you
checked. Selection of the sort option is limited to only one field all other fields will be set to n/a by the
feature. 
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7. Drag and drop your rows to change their display order in the auto-complete window.

8. Click OK to save your changes.

Auto-Complete in Inventory File Item Number

Auto-Complete In Create Invoice for Customer Number

The Auto-Complete feature works for any combination of letters and numbers. The auto-complete search look-
up will check the customer number field in addition to the Company, Address1 and City fields for a possible
match to the text entered in the identifier field or whatever fields you have set in the Lookup configuration.

· If a new customer needs to be created on the fly just click the Create New  button. 

· In the example below we enter part of a company name in the Customer No. field to find our customer. It
finds matches in the Cust # and Company fields. 
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 In this example the text is entered and the look-up process does not find a match in the
database. The search results area displays <No data to display>. 
 

Hit the <Enter> key and the Invalid Customer Number message displays giving you the option to create a
new customer. 

Click Yes on the Invalid Customer Number message and the Customer File Maintenance screen will open. 

The customer number field is
populated so you can quickly
add the new customer.

· This same add process is used in Create Invoice to add new items and in Vendor File Maintenance to add
new vendors.

Auto-Complete In Create Invoice for Item Number

· When you need to quickly add a new item to the Inventory file on the fly just click the Create New 
 button. 

· The Auto-Complete search will check the Item Number, Brand Name and Description field for matches. Here
we began to enter Description letters in the item number field to find our item.
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· PC. items will be shown in green text to help you differentiate them from other item units of measure, like
CASE.

· Here we entered part of the Brand Name in the item number field to find items from that brand.

· If you know your item numbers you can begin entering the numbers and quickly click and select the item.
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 In Create Invoice part of the item number was entered into the Item # field and the item
number was not found. 

When you hit the <Enter> key you will get the Invalid Item Number message. Click Yes to the message and
the Inventory File Maintenance screen will open so you can add the new item.

The item number you entered will already be
loaded in the Item Number field and is not
editable. 

"(Create Invoice)" will appear in the top left
corner indicating what system feature opened
the screen.

Auto-Complete In Create Invoice for Item Number
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Auto-Complete In Change Invoice for Invoice Number
Need to make that quick change to an invoice for your customer? 
· Just start typing the Ship-to Company name in the Invoice No. field and you got your customer's invoices. A

quick convenient way to provide the best service to your valued customers.

· If you know the range of your recent invoice numbers you can begin typing the first few numbers and you
have your list of recent invoices. 

· Only in Change Invoice the search for the Invoice Number gives you the choice of either the “C” for Current
file or “H” for History file. 

· You will click the letter next to the Configure icon in the bottom left corner of the auto complete window to
swap to the other file.
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Auto-Complete in Vendor File Maintenance for Vendor Number
Quickly find the vendors you need to complete that PO.
 
Here we typed the letters "HER" in the
Vendor Number field. 

The auto-complete look-up results list
possible vendor number values, a
quicker selection method.

If you do not find a match in the    
auto-complete look-up results the
Confirm message will display asking if
you would like to add the new vendor
number. 

Click Yes in response to the Confirm
message and the Vendor File
Maintenance screen opens with a new
screen ready to add your new vendor
to the database.
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Chapter 7
Using Dashboards
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7 Using Dashboards
entrée Version 4 introduces the Dashboards feature that we built from the ground-up and was made possible
by our move to the SQL database platform. Dashboards are the ultimate tool for organizing and analyzing your
business data.

The actual term for our dashboards is called a "Pivot Grid" or "Pivot Table", which is commonly used in
business intelligence software. This tool helps the user recognize data patterns that help to build advanced
data models quickly. With pivot tables, users can define and store sets of categories, then change views by
dragging category names with the mouse. This core functionality provides the model for pivot tables which  we
have embraced in the entrée V4 SQL Dashboards. It provides a highly flexible means for a food distributor to
analyze and grasp trends from the mountains of complex data which is normally lost by simply printing reports.

You will find a Dashboards   or Sales    button integrated into the
Inventory, Customer, Vendor, Salesperson, Brand and Class File Maintenance screens. The main function is to
summarize large amounts of information and represent it in a cross-tabulated form.

For instance, you can analyze sales during specific periods (years, quarterly intervals, months, weeks) for
each customer, item, vendor, salesperson, brand or class, many of the dashboards include "drill down"
features which allow you to see specific information, such as all the line items of a selected invoice.

The dashboards allow you to visualize your data by summarizing into different charting diagram styles
including: pie charts, line charts, bar charts and area charts.

Dashboards have an interactive control, permitting you to easily reorganize and modify the layout using drag-
and-drop. As a result, your business data will be re-summarized according to the new layout of the column and
row fields, so an end-user can easily alter a report to display the information they need in the way they need it.
Your dashboard configurations can be saved and loaded for sharing with other users in your company.

The Dashboards feature includes full reporting capabilities, so you can easily print to paper or export to Excel
or HTML. Advanced data filtering is also provided for more sophisticated users.

The following topics are covered in the rest of this chapter to fully demonstrate the use of dashboards within the
system.

· Dashboard Features

· Inventory Dashboards

· Brand Sales Dashboard

· Class Sales Dashboard

· Customer Dashboards

· Vendor Dashboards

· Salesperson Dashboards

· Summary Dashboards

7.1 Dashboard Features

· Dashboard Menus 
Many dashboards in entrée version 4 have a drop down menu arrow on the Dashboards button to access the
dashboards specifically designed for the Inventory, Customer, Vendor, Salesperson, Brand and Class Files.
These custom menus will be discussed later in this document.
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· Unique Data Icons       

Our dashboard design includes unique icons for each type of data so they can easily be recognized.

· Navigation 
Using left and right arrows provide the
ability to move between different entries
in the dashboard without having to close
the current dashboard.

· Dashboard Pivot Grid Areas
 Filter Area - Stores the data available for use in the grid. 

 Column Area - Data here will be in the columns of your chart.  

 Row Area - Data here will populated the rows of your chart.

 Data Area - This is the data you selected to analyze and run in your chart.

· Drag, Drop, Sort & Group Data 
 Easily drag and drop data from the Filter Area at the top of the screen into the Row Area to sort by those
fields. Or drag a field into the Column Area or Data Area to analyze those numeric fields to see different data
patterns. 

 In the example below the Row Area contained Invoice Month, Item, Invoice Number. Then
we clicked the “Customer” in the Filter Area and dragged it to the Row Area to add “Customer” as the fourth
grouping level.
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· PivotGrid Data Pre-filter Feature

 Click the Pre-filter button, on the right side of the Prefilter bar area, to access the Filter builder
dialog  (see the following Data Prefilter section). The Filter builder dialog is where you can select a Group
(data) to be pre-filtered with conditions to further restrict the data you analyze in the dashboard. 

Right click on the Group, Condition or Value text box to make a selections from the list. The Group list for
inventory is on the right.

In this Filter builder example the pre-filter of Unit Price is greater than 11 has been created. Click Save As to
save for reuse. You can see the results of this filter on the Inventory Sales dashboard in the following Data
Prefilter section.

 Click to access the Add Condition, Add Group and Remove Row options.
 Apply: Pre-filters can be applied to a dashboard and not saved but will only be available while you are in

the current dashboard session.

 Save As: Pre-filters can be saved with a name for future use. You must create a folder on your
computer to store your saved Prefilter during the saving process.

 Open: Used to locate and open saved filters for the current dashboard.

 Prefilter Controls: On the left side of the Prefilter bar area is where you can select from the applied
prefilters or click the red X box to remove  the pre-filters completely from the data in the dashboard (see
the following Data Prefilter section).

· PivotGrid Data Prefilter Feature
The Prefilter bar area, outlined in red, is where you create, save and control your prefilters.  

 Clicking the Prefilter button on the right side of the Prefilter bar opens the Filter builder dialog as
described on the previous page.
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 Inventory Sales
The prefilter of “Unit Price greater than 11”, (shown in the previous section), has been applied to the item. The
Data Area Unit Price column and the Column diagram chart below reflect the prefiltered conditions.

 
· Row Controls: Row data hierarchy can be expanded or collapsed using the plus or minus button.

· Sort Controls: The Sort arrow button on the right side of the Filter data and Row data controls sort in

ascending or descending order as desired. 

· Numeric Data: If a data group has an “[N]” following the data name this means it is numeric and follows
those  constraints in the entrée system. Sort results will reflect the same constraints.
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· Multiple Charting Style Options 
Generates a diagram to visualize your
data using any one of eight different
chart styles for the Summary Chart
including: 

 Area

 Bar

 Column

 Line

 Pie

 Stacked Area

 Stacked Bar

 Stacked Columns

· Diagram Area Options
The Diagram area not only generates the Summary Chart but for some customer and salesperson
dashboards there are additional menu and grouping options.

Header: Shows the header details for the selected. See the Customer Sales Dashboard in the Customer
Dashboard section of this chapter for an example.

Items: Shows item details for selected
customer, salesperson or invoice
number. See the Customer Payments
Dashboard in the Customer
Dashboard section of this chapter for
an example.

Drag a column header here to group by that column: Drag any field from the columns listed in the
diagram area to the gray drag to bar to group data by that column.
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Click here to show/hide/move
columns:

 Click the icon to open the
drop down list of columns in
the diagram area. 

 Check columns to add
them to the column list.

 Uncheck columns to
remove the column from
display.

 Drag columns to new
positions in the column list
to rearrange them for your
needs.

· Export / Print Dashboard Reports 
From the File menu you can Export or
Print a hard copy of your dashboard
analysis.
 

Export: Once you have done your
analysis in a dashboard you can export
the data to Excel, Text, HTML or XML
using the File menu. > Export menu
path.

Exporting Reports to Excel
1. Use menu path: File >Export > Excel.

2. The Save As dialog box will open. It will be pointing to your NECS_Shared folder for the 01 company. 

 On the Save As screen is a Hide Folders button when enabled the dialog screen below is

what you will see. You will normally see the Browse Folders screen with all the drives and folders listed on
the left as you have seen many times before.
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3. File Name: Enter a meaningful file name for your report. The system automatically wrote “History Export” in
the file name field when it opened.

To make the file name more meaningful we added “CA”, our Salesperson’s initials, “Tyson”, the brand
selected in the Brand dashboard and Sales.  

4. Save as type: You do not have to make any selection it knows your selection from the main menu.

5. Click Save and in the background the report is exported as an Excel file to the designated folder. 

6. Now use Excel to access the report data. 

 Brand Sales Report 
The report example below was created in the Brand dashboard to show sales figures for “Tyson” brand items
for our salesperson Chris.

· Custom Dashboard Configurations 
 

entrée provides default configurations for all dashboards. You are encouraged to customize dashboard
analysis and save those custom configurations to fit your business needs. 
 

Saving dashboard configurations you have customized will allow you to more quickly access the vital
information to keep on top of activity in your business.

Each dashboard screen has the Configuration option in the menu in the top left side of the screen.
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Managing Dashboard Configurations
Once you have spent the time
to customize a dashboard and
want to save that custom
configuration for reuse click
the Save as New option in the
Configuration menu.  

In the Save Configuration
dialog you will enter a unique
and descriptive Configuration
Name.

Check the box to enable these
options:

 Set as Default
for current user.

 Set as Default
for users without
default
configurations.

 Auto Expand All
Rows.

You have the option to lock the saved configuration so only you will be able to save or delete it.
 Type a password in the text box for Enter lock password.

Once the first configuration is saved the remainder of the Configuration menu options will display including:
 Load
 Edit Current
 Set Current as Default
 Lock Current
 Delete Current
 Export Current Configuration
 Export All Configurations
 Import Configurations 

Here the “Customer Items By
Invoice” configuration was selected
from the Load option in the
Configuration menu. 

To see what this saved configuration does see the Customer Sales By Item configuration example in the
Customer Dashboards section.
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7.2 Inventory Dashboards
To access the Inventory File dashboard first locate the item the Dashboard button (outlined in red below) will
have a drop down menu where you can select the dashboard you would like to open.

entrée version 4 has built into it a database of over 600 brands with their logos and URLs which can be used
to provide further details about items in your inventory via the Brand drop down menu shown here. 

The Inventory Maintenance dashboards
menu has six different dashboards.

 Sales

 Purchases

 Returns

 Short Ships

 Compare Sales by Years

 Backorders

 Lot History

 Item Short Ships 

 

Inventory Returns
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Inventory Compare Sales by Years

In this dashboard the Sales diff. % column will show you the growth percent in green with an up arrow or the
shrinkage in red with a down arrow so you can quickly see the sales comparisons. 
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Inventory Sales

Inventory Purchases
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7.3 Brand Dashboard
To access the Brand Sales dashboard first locate the item and click the Dashboard button. Brand only has
a Sales dashboard. As you can see in the Brand Maintenance screen on the right the brand URL and brand
logo are a part of the brand information. 

entrée version 4 has built into it a
database of over 600 brands with their
logos and URLs.

The brands database is accessible
through the Add and Edit features in the
Brand Maintenance dialog.

· Brands Update Utility Option
During the process to update to version 4 you
will have the option to automatically install the
brand logos and URLs for the brands already in
your system. 

The information in the NECS reference database for brands will grow over time as NECS adds information for
new brands. 
 

 Brand Sales for “Breakstone” using the system default dashboard configuration. 
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7.4 Class Dashboard
To access the Class Sales
dashboard first locate the item
and click the Dashboard button.

Class only has a Sales
dashboard. 

 Class Sales for "Cheese” using the system default configuration for the class.
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7.5 Customer Dashboard
To access the Customer dashboards first locate the desired customer in Customer  Maintenance. Then click
the Dashboard button to make a selection from the drop down menu. 

 The Customer Maintenance dashboards are:
 Sales
 Payments
 Compare Sales 
 Returns
 Short Ships
 Backorders

 Customer Compare Sales
In this dashboard the Sales diff. % column for the selected year and the two past years will show you the
growth percent in green with an up arrow or the shrinkage in red with a down arrow so you can quickly see
the customer sales comparisons. 
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 Customer Sales with Invoice Number
In the system default dashboard configuration for Customer Sales you will see the sales by Invoice Month with
the monthly totals for that customer.
Below we added the Invoice No. field to the row area to add a second group to the analysis. The invoice data
enabled the display of information in the Items Tab of the diagram area below when an Invoice was selected. 

· Diagram Area Controls Overview
Once the Items Tab has data to display a few tools to manage the data in the diagram area are enabled. 

These tools are:

· Drag a column header here to group by that column.

· Click here to show/hide/move columns. 

Some examples follow.
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 Customer Payments
· Drag a column header here to group by that column  
Drag any field from the columns listed in the diagram area to the gray drag to bar (outlined in red in Customer
Payments above) to group by that column. In the dashboard diagram area above the Invoice Date field was
dragged to the gray bar to group the Header tab data.

· Click here to show/hide/move columns  

 Click the icon to open the drop down list of
columns in the diagram area (outlined in red on
the right) . 

 Check columns to add them to the column list
 Uncheck columns to remove the column from

display
 Drag columns to new positions in the column

list to move them.
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Header Tab  
When item 10532 Rack Of Pork is selected, in the Customer Sales By Item dashboard on the following page,
you can click the Header Tab in the diagram area to reveal the sales header details for that item as shown
below.

 Customer Sales By Item
Shown here is a configuration for Sales by Item. You are encouraged to customize the analysis to fit your
business model.
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 Customer Sales By Item with a Custom Configuration
You can access the configurations saved for a dashboard in the drop down menu in the top of the screen on
the far right (outlined in red). In this example the saved configuration “Customer Items By Invoice”, discussed
previously in Managing Dashboard Configurations, was applied to the dashboard. 

Items Tab
If there is a set default configuration it will automatically be loaded and applied to the dashboard
data when it opens. Once the Invoice No. field was added to the row area on the left individual invoices were
listed and the Items Tab now had data to display.

Invoice 231312D was selected and then the Items Tab in the lower section of the screen was clicked in the
diagram area. Now the tab shows the items on that invoice with the item details as shown in our example.



Using Dashboards 84

 Customer Returns
Here you will see the record of returns from each of your customers. You can use this dashboard to quickly
identify any patterns or recurring problems with a customer. Columns are grouped using the Return Reason
codes built into the entrée system.

 Customer Short Ships
Here you see the Short Sales Lost and the Short GP Lost columns will quickly tell you where the potential
sales from the customer were lost. This dashboard will help you find patterns where possibly the same item
caused lost sales with many customers. Click the + plus sign and expand the list to see what items were
involved in the lost sales.
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7.6 Vendor Dashboard
The Vendor Maintenance dashboards menu includes:  

· Purchases

· Payments

The system default dashboard configurations for Vendor Purchases and Vendor payments are shown below. 

 Vendor Purchases Dashboard
With this dashboard it is fast and easy to keep track of your purchases from the many vendors you deal with
on a daily basis.

 Vendor Payments Dashboard
It is important to manage and monitor your cash flow. The Vendor Payments dashboard allows you to verify
payments to avoid double payments and other mistakes.
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7.7 Salesperson Dashboard
To access the Salesperson dashboard first find the desired salesperson in Salesperson / Broker Maintenance.
Then click the Dashboard button to make a selection from the drop down menu. 

The Salesperson / Broker Maintenance dashboards are:
· Sales

· Sales by Item

· Compare Sales by Years

 Salesperson Sales Dashboard



entrée V4 SQL System Guide87

 Salesperson Sales By Item
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 Salesperson Compare Sales By Years
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7.8 Summary Dashboards
In V4.0.38 the new Summary Dashboard feature was implemented for Inventory, Customer and Vendor File

Maintenance. This dashboard allows you to examine up to 25 years of history data from the ARSUMRY table.

· The Summary Dashboards can be accessed via the main Dashboards ribbon menu using the Inventory,
Customer and Vendor sub-menus. 

Dashboard Ribbon Customer Menu Dashboard Ribbon Inventory Menu

Dashboard Ribbon Vendor Menu · The Summary Dashboards can also be accessed
using the Dashboards menu in the Inventory File,
Customer File and Vendor File Maintenance screens.



Using Dashboards 90

· The new Source for Categories feature has been added to dashboards in the Chart Options menu. 

This menu feature allows you to direct
the dashboard processes to only use
the data in the rows or columns you
have highlighted to generate the
summary chart.

 Be aware that some chart styles, like Stacked Area, may not provide you with a chart that

has a meaningful comparison of the data. Some experimentation may be required to work with this new feature

and various chart styles. 

The Rows and Columns options in the menu allow you to switch the graph data source category for the

horizontal x-axis in the chart. The vertical y-axis will reflect the range of data values for the selected data

comparison.

 Summary Dashboards Source for Categories Options 
· First the 2011 and 2012 columns were highlighted and the Columns option selected in the menu.
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· The first chart was generated for Columns and  used the selected column’s headers as the x-axis
categories. 

The result was a comparison of the Summary data for the years 2011 and 2012 with a column for each month. 

(Note: The two charts below were edited to remove some columns to fit on the page.)

· Using the same data when the Rows option is selected the months are the x-axis categories. 

The years 2011 and 2012 are the yellow and blue columns in the chart for each month.
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 Summary Dashboard with Invalid Anaylysis 
This is an example of a Summary Dashboard for Customer Summary Sales that provided no real
analysis of the sales data because of the choices made for the Source for Categories (columns)
and the Type of Chart generated (Stacked Area).

As you can see below the data for the two years selected, 2011 and 2012, is not compared
properly so there is no analysis just a meaningless stack of data.

So be aware that your Summary Dashboard choices can impact whether you get a valid analysis
generated.



Chapter 8
V4 SQL Search Features
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8 V4 SQL Search Features
The entrée V4 SQL has brought with it advances in search capabilities and options. The integrated search
engine allows users to quickly customize a search and quickly locate the data they need. This chapter will
provide an overview of the latest search engine features. 

 Any time the  search button is displayed in the entrée system, the appropriate search screen
can be opened by clicking that button. Pressing the F5 key, while the cursor is located in a field that has a
search button, will open the search screen.

New Search System Features
· Keystroke Delay Slider
V4 feature enhancements include the new Keystroke Delay Slider feature to searching. This feature allows you
to control the amount of time that the system waits before applying a search term that you have typed in. 

Moving the slider toward the “Short” setting reduces the time that the system waits but this means that you
have to type faster to stay ahead of the computer. 

Moving it toward the “Long” setting means you are able to type more slowly but the system will take longer to
respond to your input. 

This is a “per user” setting but the same setting applies across all searches. However there are separate
settings for the “Classic” and “Server Mode” search styles discussed below.
 

· Setting Search System Defaults
In entrée V4 SQL the search system has a few new features one to configure the default search style and the
other to refresh the search screen data whenever you like. Search Style and Matching Method are two new
customizable features of the search system. 

You can set the default Search Style for entrée V4 SQL in the “Search System Options” configuration
accessed via Additional Features on the System Options tab of System Preferences. See the Additional
Features section of the System Options chapter for detailed information.

New Search Configuration Miscellaneous Settings

· Search Style 
This new feature allows you to select whichever search style works the best for you and allows you to make
that the default for all of your entrée searches. 

 Default: The default search style is configured in the “Search System Options” utility found in System
Options Additional Features. See the Additional Features section of the System Options chapter for
more detailed information.
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 Classic

 Server Mode 

· Matching Method 
 Default - The default matching method built into the entrée system for that screen.

 Match - Uses the entire input phrase as a whole for the search ('TEST ITEM%') rather than breaking out
each word and matching the words individually  ('TEST%' and 'ITEM%').

 Contains

See the Miscellaneous Settings tab topic for more details about the new Search Style and
Matching Method options.

Keyboard Shortcut
In the entrée V4 search system you can now use the entrée V3 keyboard short cut of [CTRL ]+ left/right

Arrow to move the search box along the top of the grid. 

Search Refresh Button
Caching of the search results can cause the information being shown to become stale (out-of-date) especially
in files that change frequently throughout the business day like the Invoices database. The Refresh button in
the lower right-hand corner of the search screen when clicked will reload the current search with the latest
available information.

So as new invoices are
processed in the system during
the day when you hit the Refresh
button it will show all the invoices
in the system at that moment for
you to search. 
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Topics covered in the V4 Search Features Chapter

· Performing a Search
· Search Configuration Overview
· Inventory Search screen
· DOT Foods Inventory
· Customer Search screen
· Salesperson Search screen
· Vendor Search screen
· Manufacturer Search screen
· Comment Search screen
· Invoice Search screen
· Lot Location Search screen
· Purchase Order Search screen

8.1 Performing a Search
Configurations for searching the Inventory, Customer, Salesperson, Vendor, Manufacturer, Comment, Invoice,

Lot Location and Purchase Order files can easily be customized in entrée by clicking the   Configure
button. See the Search Configuration Overview section of this chapter for details.

General Search Features
Once the desired search screen opens a white edit box will be located above the default search column. In the
Inventory Search screen below the Description column is default. Just start typing the first characters of the
value you are seeking and entrée will dynamically move you closer to the correct value. 

 For the letters "toma" in the Description column the search results are shown below. 
 

 

· If you wish to search on a different value than the default for that file click the desired column heading and
the white edit area will move above that field. Now enter your search text.

·  You may re-size a column by clicking and dragging either edge of the column title.  

·  The order of the columns may be changed by clicking the column title and dragging it to a new position.

·  Any changes made to the search window are for the current search only.  
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· Sort any column in ascending or descending
order by clicking the column header to change
the sort arrow into the desired direction.

In the example on the right
the Item # column is being sorted in descending
order. 

If you click the Item # header again it will
reverse the sort order to ascending.

· Drag any column heading to the "Drag any column header here to group by that column" area and the
screen data will automatically be grouped by that column. Use the + and - icons to expand or collapse each
group list. 

Below the Inventory Search screen was grouped by Temp Zone and the search text box is
in the Description column.

· If you would like to save your changes for all subsequent searches you will need to use the Search

Configuration window accessed by clicking the  Configure button, located in the top left corner of all
entrée search grids. The Search Configuration Overview section follows with complete details.

8.2 Search Configuration Overview
Configurations for searching the Inventory, Customer, Salesperson, Vendor, Manufacturer, Comment, Invoice,
Lot Location and Purchase Order files can easily be customized in entrée.

When you click the  Configure button you will
have a drop down menu listing Personal
Configuration options and Local Default Configuration
options.

· Be sure to check the list of columns on a regular basis because new columns are being added all the time.
In the version 4.0.29 release the “Pc Item?” and “Spec Ord?” columns were added to Inventory searches.
Both columns show “Yes”/”No” values:
 “Pc Item?” is “Yes” if the item Units of Measure is “PC.” 
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 If “Spec Ord?” is “Yes” if the item is defined as a “Special Order” item.

 The Configure button will be hidden if the user does not have authorization to create a Personal
Default configuration.

Local Default Configuration
Local Default search configurations are setup by an authorized user, usually the System Administrator, and
that configuration will become the search default for all users of entrée.

The System Administrator can customize the Local Default search configuration to align with the way you do
business. This option allows each distributor to create their own preferred search layout and have it
automatically applied to everyone without the need to update each workstation individually.
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Personal Default Configuration
The Personal Default
Configuration option allows only
the authorized User Account to
save a customized search
configuration that only that user
will see and use.

A user who does not have the
Personal Default Configuration
authorization is prevented from
making any changes to the
search configuration including not
being able to change column
positions, column width, or
column grouping.

Any saved Personal Default
Configurations will be ignored in
favor of the Local Default or the
built-in default (the default
embedded in the entrée code). 

 The Local Default and Personal Default configuration windows use the same tabs and search
options as shown here.

Search Configuration Password Options
In the  entrée Security Manager > Settings >
Miscellaneous options list there are two new
options controlling whether a User Account
can create Local or Personal search
configurations. These options are #107 and
#108. Remove the check mark for these
options to turn off this feature for individual user
accounts.

· Option #107 is "Allow creation of 'Local
Default search configurations" controls
whether or not a User Account is authorized
to create search configurations that will
become the Local Default for all users in
entrée. This authorization is usually given to
the System Administrator and is tightly
controlled.

· Option #108 is "Allow creation of
personal search configurations" which
controls whether or not the User Account is
allowed to save a personal search
configuration. Each business can decide if
they will allow employees to personalize
their search screens or use a standard
screen for the entire company.
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Setting Search Configurations
Whether a Local Default or a Personal configuration in entrée V4 SQL the new Search Configuration window
has the same four tabs to assist you with search customization. 

These four Search Configuration tabs will be covered in the next sections of this chapter:
 

· Grid Columns
· Column Grouping
· Information Panel
· Miscellaneous Settings

Using the Available / Displayed Column Configuration Feature
The Grids Columns, Column Grouping and Information Panel tabs will use the Available / Display lists to
control columns in the configuration. Below is an explanation of the controls in the Available / Display columns
feature.

  

 

 

The Available Columns list contains all of the available fields that are not currently
displayed on the current search screen. 

 

· A column in the Available columns list can be moved to the Displayed columns list

by selecting the column to move and clicking the  button.
 

The Displayed Columns list contains all of the fields that will be displayed in the 
current search screen. 

 

· A column in the Displayed columns list can be removed and put back in the

Available columns list by selecting the column to remove and clicking the 
button.

Settings Displayed Column Order
· The first field in the displayed fields list will appear on the far left of the search    grid

with each subsequent field appearing to the right of the previous one. To relocate a
field in the Displayed columns list, select it with your mouse and click the

appropriate  or  buttons until it is where you would like it.

Remove All Columns
· All of the columns in the Displayed columns list can be removed at once by clicking

the  button.

Add All Columns
· All of the columns in the Available columns list can be added to the Displayed

columns list at once by clicking the  button.
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Unsaved Configuration Changes
Once you have configured your Local Default or Personal Default search screen and click OK. Now use your
customized search configuration. When you exit the search screen, if you have changed a search
configuration, a message will be displayed. The message displayed is different for Local and Personal search
configuration defaults.

· If you changed the Local Default this
Unsaved Changes message will
display. 

 Click No here unless
you want the search defaults for every
entrée user updated. 

· If you changed the Personal Default
configuration this message will display.
Click Yes here if you want to save your
recent changes as your new default. 

· Click No here and your Personal
Default configuration will not be
changed

8.2.1 Grid Columns Tab

The Grid Columns tab is used to configure the default behavior of the current search screen. Here you can
customize which columns will be displayed and their order, the default sort column and the default search
column. 

Controlling the Search Screen Grid Columns 
· Move a column from the Available Columns list to the Displayed Columns list by selecting the column to

move and clicking the  button. You can do the reverse with the opposite arrow as you customize your
configuration.

· Organize the column order in the Displayed Columns list using the  arrows.

  Find a detailed explanation of the Available / Displayed Columns feature in the Search
Configuration Overview section of this chapter.
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· Default Sort Column
Once the columns to be
displayed are added to the 
Displayed Columns area use
this drop down menu to select
your default sort column.  

Click OK to save your
selections.

Typically Class, as seen in the image below, or Item # are used as the default sort column
for Inventory Search.

8.2.2 Column Grouping Tab

The Column Grouping tab is used to configure a hierarchical data structure in the Inventory Search screen and
will become the default behavior of the current search screen. In the column grouping example below Class is
first followed by Item # then Onhand Qty.  The top column in the Displayed fields list is the first level of the
grouping hierarchy.

Customizing Column Grouping
· Move a column from the Available Columns list to the Displayed Columns list by selecting the column to

move and clicking the  button.

· Organize the column order in the Displayed Columns list using the  arrows.

  Find a detailed explanation of the Available / Displayed Columns feature in the Search
Configuration Overview section of this chapter.
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· Click OK to save your default selections.

 Here we see the columns grouped in the Inventory Search screen according to our Column
Grouping tab settings above, Class, Item # and Onhand Qty. In Inventory Search once you open the 3 grouping
levels the rest of the columns are displayed as shown in the Anti-Oxidants example here.
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8.2.3 Information Panel Tab

The Information Panel feature is used to further customize your view of an item's information by adding more
item information in the panel located in the lower section of the Inventory, Customer, Salesperson, Vendor,
Invoice and Purchase Order search screens. 

When you click an item in the Inventory search screen more item information can be displayed in the
Information Panel below. Here you see the Information Panel display created by the Personal Default search
configuration shown below.

Customizing the Information Panel
· Move a column from the Available Columns list to the Displayed Columns list by selecting the column to

move and clicking the  button.

· Organize the column order in the Displayed Columns list using the  arrows.

· Click OK to save your
selections.

· The Preview area below
will show the Displayed
fields as they will appear in
the Information Panel. 

  
Find detailed explanations of
the Available / Displayed
Columns feature in the
Search Configuration
Overview section of this
chapter.



entrée V4 SQL System Guide105

8.2.4 Miscellaneous Settings Tab

The Miscellaneous Settings tab options will vary for each of the files; Inventory, Customer, Salesperson,
Vendor, Manufacturer, Comment, Invoice, Lot Location and Purchase Order. 

· All search configuration
dialogs in the system will
have Search Style and
Matching method on the
Miscellaneous Settings
tab. 

Search Style
Select whichever search style works the best for your environment and make that the default for all of your
searches. At NECS we have found that the “Classic” style can be faster than “Server Mode” and in other cases
they are more or less the same speed in returning search results. Choose what works best in within your
technology and networking environment.

 Default: The default search style is configured in the “Search System Options” utility found in System
Options Additional Features. See the Additional Features section of the System Options chapter for
more detailed information.

 Classic: To try and maximize performance in the search grid the "buffering" option is enabled. So it only
physically loads a set number of records into the grid at any one time (currently set to 150 records).
Column grouping is not supported in this search style. When you select it a message box will display
warning you about this and ask if you would like to proceed.

 Server Mode: Collects all of the records in the database at once to load the search grid.

 Having your Personal or Local Default configurations explicitly set to "Classic" Search
Style overrides the default setting in System Preferences. 

Matching Method
 Default - The default matching method built into the entrée system for that screen.

 Match: By default the entrée V4 SQL search system will use Match. You can use the Up, Down,
Home, End, Page Up and Page Down keys on your keyboard in the search screen once you run your
initial search. 

 Contains: Performs a partial match which is good if you only know a portion of the value you are looking
for. The search screen will update immediately as you enter the search text, only showing items that
contain the text you are typing. 

 In each search configuration in the system you can override the Search Style or Matching

method setting on a “per search” basis using the Configure button and changing the options on the
Miscellaneous Settings Tab.

· At this time there are some files that only have the Matching method option in the Miscellaneous Settings
Tab. These files are: Purchase Order, Manufacturer, Vendor, Salesperson, Invoice, Comment and
Warehouse Location.
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Inventory Search Miscellaneous Settings
In addition to Search Style and
Matching method you have the
following options.

Buttons:
· Show Lots button

· Show Order Breakdown
button

· Show Item Notes button

  If you do not have
Lots turned on in entrée the
Show Lots button will not be
displayed.

Images:
· Show Image Panel - Check to display the image panel to the left of the Information Panel at the bottom of

the inventory search screen. 

Once the Image Panel is enabled you can choose what images to display in the panel depending on the
images you have in your entrée system.

 Show Item Image - Assigned to the item in
Inventory File Maintenance.

 Show Brand Image - Added to entrée in Brand
Maintenance and assigned to the item in
Inventory File Maintenance.



entrée V4 SQL System Guide107

 Show Class Image - Added to entrée in Class
Maintenance and assigned to the item in
Inventory File Maintenance.

Customer Search Miscellaneous Settings
In addition to Search Style and
Matching method you have the
following options.

· Show Image Panel - Check to
display the image panel to the left of
the Information Panel at the bottom
of the search screen. 

 Show Customer Image - 
Assigned in entrée Customer
File Maintenance.

 The Customer Search screen below shows the image panel in the lower left corner.  When
the customer's small image in the image panel is clicked a larger image is displayed in the Customer Image
Display dialog box. Click the red X box to close the image display box.
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Vendor Search Miscellaneous Settings
In addition to Search Style and Matching method you have the following options you have the new vendor
image.

· Show Image Panel - Check to display the image panel to the left of the Vendor Panel at the bottom of the
search screen (image below). 
 Show Customer Image - Assigned in entrée Vendor File Maintenance.

8.3 Inventory Search Screen
The Inventory Search screen will assist you in looking up any inventory item. 
 

· Searches can be performed using any column in the search screen. 
· Click the desired column and enter your search text in the white search text box that appears above the

column. 
· Typically the Item #, Description, Brand, Class or Manufacturer Item Number are used.

· When you click an item in the Inventory search screen more item information can be displayed in the
Information Panel below if the configuration for the Information Panel tab has columns in the Displayed fields
section in your search configuration.
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Inventory Search Buttons

Lots Button
· If the currently selected item is a Lot based item the Lots button will be enabled as seen in the image below.

· Click the Lots button to view the Lot Listing details for the selected item.

Order Breakdown Button
· Click the Order Breakdown button for the selected item to see the next seven days of orders. Here you

see the information for a Lot Item.
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Item Notes Button
· Click the Item Notes button to view any notes on the item.

· If no there are no Item Notes this message box
will display.

· See the Search Configuration Overview topic for more information about searching capabilities and
options.

8.3.1 DOT Foods Inventory

The entrée.DOT software add-on module is designed for NECS entrée users who purchase from Dot Foods.
It allows entrée users to automate procedures related to costs, pricing, purchasing and receiving, along with
the ability to make your entire order guide from Dot Foods available to your customers.

Items purchased from Dot Foods can be integrated into the NECS entrée system providing you the ability to
drastically increase the number of products you can supply to your customers – without having to increase the
size of your warehouse.

 If your company does not have the entrée.DOT software module you will not see this feature.

 entrée V4 SQL gives you the ability to control whether items from the DOT Foods catalog are visible or
hidden in the Inventory Search screen.

The DOT icon in the lower left corner of the Inventory Search screen is the switch used to hide or show items
from the DOT Foods catalog.

http://www.necs.com/dot/
http://www.dotfoods.com/
http://www.necs.com/dot/
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When the DOT icon is gray DOT Foods catalog
items are hidden.

Click the gray DOT icon to load your DOT Foods
Catalog items into the Inventory Search screen.

When the DOT icon is the color blue your DOT
Foods catalog items are loaded and visible.

Click the blue DOT icon to hide the DOT Foods
Catalog items again.

· In the Inventory Search screen DOT Foods item numbers usually begin with the letter 'Z' as seen in the
example below.

Manufacturer's Item Number and DOT Foods
Why would you need the manufacturer’s item number?
If you purchase from Dot Foods or would like to in the future this field will be used for those items. Also using
the manufacturer and their item numbers on your entrée inventory items can assist you in the event of product
recalls. Over 65 reports in entrée can print, group by and sort by Manufacturer ID, Manufacturer Name and
Manufacturer Item Number as well as filter by Manufacturer ID. 

How to add manufacturer’s item numbers: Use Manufacturer File Maintenance to add manufacturers to
the entrée system. Then add the manufacturer’s item numbers to each item using the Vendor tab in Inventory
File Maintenance. 
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8.4 Customer Search Screen
The Customer Search screen will assist you in looking up any customer in entrée. 
 

· entrée will allow users to perform searches against any of the columns in the grid including customer
number, company, bill to #, city, zip, and phone number.

· When the search configuration Miscellaneous Settings Show Customer Image option is enabled any
customer image assigned in entrée Customer File Maintenance will be displayed in the Image Panel.  Click
the customer's small image and a larger image is displayed in the Customer Image Display box as shown
below. 
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This is an example of customers grouped by City in the Customer Search when the column
header was dragged to the group by area.

· See the Search Configuration Overview topic for more information about searching capabilities and
options.

8.5 Salesperson Search Screen
The Salesperson Search screen will assist you in looking up any Salesperson or Broker. 
 

· entrée will allow users to perform searches against the salesperson's number or the salesperson's name.

This is an example of a search using the Salesperson Name field using the letters 'an' with
the Information Panel displayed.
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· See the Search Configuration Overview topic for more information about searching capabilities and
options.



entrée V4 SQL System Guide115

8.6 Vendor Search Screen
The Vendor Search screen will assist you in looking up any vendors that have been added to the system using
Vendor File maintenance. 

· Searches can be performed using any column in the search screen grid. 

This is an example of a search using the Company field using the letters 'do' with the
Information Panel displayed below.

· Click the desired column and enter your search text in the white search text box that appears above the
selected column. 

· See the Search Configuration Overview topic for more information about searching capabilities and
options.
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8.7 Manufacturer Search Screen
The Manufacturer Search screen will assist you in looking up any vendors that have been added to the system
using Manufacturer File maintenance. 

· Searches can be performed using any column in the search screen. 
· Click the desired column and enter your search text in the white search text box that appears above the

column. 

· See the Search Configuration Overview topic for more information about searching capabilities and
options.
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8.8 Comment Search Screen
The Comment Search screen will assist you in looking up any Comment ID. 
 

· entrée will list each line of text
in the comment on the
Comment Search screen.

 
·  When selecting a comment be

sure to select the first line of
the desired comment. 

·  The Comment Search screen
displays the comment ID and
the Comment Text. In the
image here the search text box
is over the Comment Text field
where you can enter text or
words to search for in the
Comment Text field. In this
example we searched for 'time'
in the Comment Text with the
results you see below.

This is an example of comment grouped by ID in the Comment Search when the column
header was dragged to the group by area. 

· See the Search Configuration Overview topic for more information about searching capabilities and
options.
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8.9 Invoice Search Screen
The Invoice Search screen will assist users in looking up any invoice number. The addition of “Current” or
”History” file selection along with the Match / Contains feature allows you to perform a more focused search
especially when looking for an older invoice that may be in the History file.

 Click the Configure button and customize the columns used in the search screen.

To support the Electronic
Warehouse Manager the 
EWM Picked? column has
been added as an option. 

When the column has a
"Yes" the newest invoice
revision has been fully
picked.

 entrée will allow users to perform searches against any column including the invoice number, customer
number, invoice date, order number, ship to company, and the bill to company. 
 

· Invoices that have been moved to the history files by the Close Period Utility may also be searched for here
by clicking the History option.

· When a date field is selected the calendar is displayed to allow you to search by date.
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This is an example of invoices
grouped by Bill-to Company in
the Invoice Search when the
column header was dragged to
the group by area.



V4 SQL Search Features 120

This is an example of invoices
grouped by Inv Date in the
Invoice Search when the column
header was dragged to the group
by area.

· See the Search Configuration Overview topic for more information about searching capabilities and
options.

8.10 Warehouse Location Search screen
The Warehouse Location Search screen is accessed in the File menu and will assist users in looking up
any Lot's location ID.

· The Warehouse Location search
screen can display these fields for
lots: Location, Reference, Description
of the location, and the designated
Item # for that location.  
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· The Warehouse Location search
screen is only search-able on the 
Location field.

· In this example the Information Panel
below has been enabled by adding
columns to the Displayed fields list
above.

· See the Search Configuration Overview topic for more information about searching capabilities and
options.
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8.11 Purchase Order Search Screen
The Purchase Order Search screen will assist users in looking up any purchase order numbers. entrée allow
users to perform searches against any column including the purchase order number, vendor number, and the
vendor name.

 Use the Current / History file selection options to limit the number of records searched. 
 Searching the "Current" Purchase Order file will not include "Closed" Purchase Orders.
 Searching the "History" file will show you the "Closed" Purchase Orders.

 

The example below the PO Search Configuration dialog where you can customize the
columns to be displayed in the search.

· See the Search Configuration Overview topic for more information about searching capabilities and
options.
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